ICSIM

Ancient Greek Drama and its Architecture as a Means to Reinforce Tourism in Greece

Loukia Martha\textsuperscript{a*}, Amalia Kotsaki\textsuperscript{b}

\textsuperscript{a} Architect desa, stage designer dea Themistokleous St. 50, 15474 Alimos, Attika, Greece
\textsuperscript{b} Architect, ass. Professor, School of Architecture, Technical University of Crete G.Sissini St. 14-16, 11528, Athens, Greece

Abstract

It’s broadly accepted that culture and especially antiquity has played a most important role in tourism policy development in Greece from early on and in comparison with other countries. Ancient architecture combined with cultural events has been one of the major elements of tourism policy. The combination of ancient theatre performances with archeological areas is one of the most appropriate applications of this approach. The objective of this paper is to explore the contemporary activity of ancient theatre as a means of tourism policy using culture as the principal asset. In order to evaluate the application of the approach in the past, a brief review of the use of the ancient theatre (performances in Greece and abroad) as a means of tourist attraction will be presented. What are the factors that make ancient theater interesting for tourism? Should an ancient Greek performance function autonomously or should it be included in a network of tourist services in order to become more attractive? What other possibilities for becoming acquainted with Greek culture does viewing an ancient theatre performance provide and what benefit does it offer as a tourism product? What promotion methods for ancient Greek theater have been applied to date by the tourism policy and what type of new media can be proposed?

1. The revival of ancient Greek drama in its natural environment - a brief history

The use of ancient theatres for hosting of performances dates from the first decades of 20th century and is associated with the progress of archaeological excavations and the restoration of ancient monuments and sites. Since 1924, the year of the foundation of the Professional Theatre School, the Odeon of Herodes Atticus, known as ‘Herodeon’ is definitely established as a site for ancient drama performances, while the Delphic Festival created by the renown poet Angelos Sikelianos and his wife Eva in 1927 and 1930, gave a new impetus to the endeavor. The attempt to combine tourism and culture was not a priority at this time. The merging of tourism and culture,
particularly of archaeological monuments and sites, will be attempted in 1929, year of the foundation of Greek National Tourism Organisation, during which archaeological sites and especially ancient theatres are included in the national strategy of tourist promotion of Greece. In parallel with the establishment of the National Theatre in 1932, the systematic research for the interpretation of ancient drama is reinforced. In 1936, the Metaxa Government, founded annual “periods of feasts” which included ancient drama performances in open ancient theatres while the National Theatre constructed wooden seats in the lower tier of the Herodeon. The public and vigorous opposition of architect-city planner Konstantinos Doxiadis to the proposals for the complete reconstruction of the Herodeon temporarily postponed the intervention.

During the German occupation, the Herodeon hosted concerts of the Athens State Orchestra as well as performances of the newly established National Opera of Greece in which the young Maria Callas, then still Maria Kalogeropoulou, played the leading role in the Beethoven opera Fidelio as well as in Protonastoras, an opera by the Greek composer Manolis Kalomoiris. The foundation of the Hellenic Festival (Athens & Epidaurus Festival), which evolved from the Athens Festival, played a decisive role in combining culture and tourism and is an important means of promoting ancient drama and the archaeological sites in which the performances take place. As far back as August 1954, the National Theatre staged the performance of Hippolytus by Euripides at the ancient theatre of Epidaurus as a trial performance with a total of 20,766 spectators during three performances. One year later, on June 19th 1955, as previously mentioned, the Epidaurus Festival was officially founded as an ancient drama festival, which takes place every summer at the Epidaurus ancient theatre. The festival officially opened with the performance of Hecuba by Euripides, directed by Alexis Minotis with Katina Paxinou in the title role. Since 1955, the festival has been held every year in Athens and Epidaurus, mainly in the Odeon of Herodes Atticus, the Lycabettus Theatre and the Ancient Theatre of Epidaurus (Geougouopoulos & Gofos, 2004).

Evidently, the festival has determined the development in the area of culture and tourism, hosting renowned Greek and foreign theater directors and actors, as well as many famous artists as production factors. Furthermore, the festival has encouraged Greek theatre companies to travel abroad acquainting worldwide the general public with ancient drama. Indicatively, the spectator capacity of Epidaurus theatre is 14,000.

Evidently, the festival has determined the development in the area of culture and tourism, hosting renowned Greek and foreign theater directors and actors, as well as many famous artists as production factors. Furthermore, the festival has encouraged Greek theatre companies to travel abroad acquainting worldwide the general public with ancient drama. Indicatively, the spectator capacity of Epidaurus theatre is 14,000. The first performance of 36 Greek dances by N. Skalkotas and conducted by Dimitris Mitropoulous in 1955. The historical presentation of Birds by Aristophanes directed by Karolos Koun - Art Theatre in 1959 - with music by Manos Hadjidakis. This performance was applauded by the international press and was duly awarded.

There were also other international performances that followed such as the interpretation of Maria Callas in Norma by Bellini in 1960 and Medea by L. Cerubini’s in 1961, the ballet Giselle with Rudolf Nurveyev and his partner Margot Fonteyn in 1963, the performance of Electra by Sophocles by the National Theatre directed by the founder of ‘Amphitheatre’ and academic Spyros A. Evangelatos, a production which revitalized both the tradition of the National Theatre as well as the institution of the Epidaurus Festival; Oresteia by Aeschylus directed by Peter Hall and the National Theatre of England, also this was the first time that a foreign director staged a performance in Epidaurus in 1982.

The Roman Odeon of Herodes Atticus, the Herodeon, with spectator capacity of 5000, was also equally successful both in quality performances as well as fame worldwide. Since 1939, performances first seen at the Herodeon such as Electra by Sophocles and Hamlet by Shakespeare have gone on tour to Cairo, Alexandria, Berlin, London etc. In 1956, an Ancient Comedy was performed for the first time at the Herodeon, Ecclesiazusae by Aristophanes, while in 1958 the success of Oedipus at Colonus, with title actor Alexis Minotis, initiated international tours and performances. In the 58 years of operation of the Athens Festival the stage of the Herodeon has hosted most of the leading artists - international and domestic in the area of music, dance and theatre during the post-war years. During the first three decades of its operation it offered to the Athenian public an invaluable contact to the international artistic scene as well as an opportunity for recognition for excelling Greek artists and performers. At the same time the ancient drama and the sites of the Athens Festival, with the theatre of Epidaurus playing a leading role, have been included decisively in the tourist strategy of Greece.
Ancient drama and music performances in ancient theatres are not limited to the two main theatres mentioned above, to which are slowly added new archaeological sites, such as the Little Theatre of Ancient Epidaurus, spectator capacity of 2000. Ancient drama performances also take place at the ancient theatres of Elis near ancient Olympia, Thassos with spectator capacity of 2000, Philippi in Macedonia and Dodona in Epirus, one of the largest and well-preserved theatres with spectator capacity 18,000. In August 2013, the recently renovated theatre of ancient Messene in the Peloponnese was added to the list.

2. The promotion of tourism and ancient theatre

The above selection of ancient theatres and ancient drama in general, as an element of tourist strategy is reflected in the images of ancient theatres of the posters of the Greek National Tourism Organisation (Ministry of Tourism-Greek National Tourism Organisation, 2007: 4-6) which however do not have the commercial potential and approach of contemporary marketing. Nevertheless, these posters (Sgartsou, 2009: 38-39) portray graphic design innovations, which successfully combine symbolic elements together with representations of the main subject and ancient theatre architecture. At the same time, ancient theatres are consistently represented among the exhibits of Greek pavilions at international tourism fairs. This constituted one of the only post-war means of promotion our country abroad, creating an early national branding (Sapounaki-Drakaki and Tzogia-Moatsou, 2010). The study of the poster’s imagery further highlights the development of the strategy to upgrade the image of Greek tourism. As early as 1955, the year of foundation of Athens and Epidaurus Festival, the tourism product becomes more complex including cultural and recreational services in combination with the traveling and accommodation of tourists. For the first time, cruises and buses journeys are offered.

This brief history has demonstrated that ancient theatres and ancient drama in general, have been major promotion means in Greek tourism strategy. This approach has had a long history and has been one of the most efficient methods for attracting tourism within the overall tourism policy of Greece since the early years of the 1950s.

3. The contemporary tourism strategy with an emphasis on tourism for the promotion of ancient drama

In an effort to determine the role of the reintroduction of ancient drama and theatres in the promotion strategy of Greek tourism, the factors that make ancient drama interesting for tourism have to be pinpointed.

- Archaeological interest. In most cases, the ancient theatres are integrated in larger archaeological sites and the viewing of a theatre performance can be included in a general tour of the archaeological site.

- Architectural interest. The ancient theatres are sites where intensive activity that created democratic institutions was achieved and are considered important monuments of Greek civilization with outstanding architectural virtues, among them the relationship between landscape and built structure. The dialogue during which the built structure surrenders itself to nature reflects the worldview of ancient Greece on the relationship of man and nature. This, together with the superb acoustics, is an important area of interest in the field of architecture. In addition, the fact that ancient theatres were built in areas of outstanding beauty enriches the experience of nature and landscape for the visitor.

- Artistic interest. The performance itself, often innovative, creates artistic interest. Theater people from all over the world dream to perform ancient drama, if not at the magical site of Epidaurus or the Herodeon in the shadow of Parthenon, at least at one of the other ancient theatres. The interpretation of the text, the stage design and the costumes, together with contemporary music composed specially for the ancient drama performance express the timeless quality of ancient drama, spatial and temporal, providing opportunities for acquaintance with Greek culture from antiquity to the present day, highlighting the timelessness with a dialogue between nature and architecture, text and space, past and present.
In addition, the uniqueness of a phenomenon that internationally expels tourist interest should be emphasized. A place may promote its image for attracting tourists by providing a competitive advantage. Therefore, regions promote themselves and their perceived competitive advantage (Kavoura, 2007). The undeniable cultural interest of the ancient theatre should be combined with a collective approach aiming at the maximization of the tourist product. As presented above, ancient theatres today, after the necessary excavations, can host important performances and constitute a network in Greece. The proposed network would have to include archaeological sites with ancient theatres as well as other touristic attractions such as contemporary cultural centres, areas with outstanding natural beauty, thematic museums and religious destinations.

The coordination of the timing of the performances during the summer months will contribute to the creation of routes and visits offering a complete thematic tourism program. The integration of the performances in a network of tourist facilities, such as cruises, something that is continuously increasing in our country, can be a positive asset improving their attraction. The development of cruises offers the opportunity to exceed national boarders and to create a broader cultural area in East Mediterranean based on Hellenistic theatres in Greece, Cyprus, South Italy and Turkey. In this way, we can create a thematic cultural tourism which has an international profile focusing on visitors of a high social and educational level, increasing the tourist flow.

4. Conclusions

The above, however, can be achieved only with appropriate information and international promotion, specially adapted for each interest group, -for example, tourists can then be segmented based on their preferences -for example, religious heritage tourism aimed at the Russian Orthodox tourists (Kavoura, 2013)- and the use of the internet. The development of suitable websites -the use of Information and Communication Technologies offer people the ability to make use of them to engage in meaningful social practices (Kavoura & Katsoni, 2013) in which the interest in ancient theatres and the performances they host are visually highlighted, digital guided tours via cell phones, cultural routes and three-dimensional visualizations are proposals for promoting these great moments of the Greek spirit. This will contribute not only in attracting visitors to Greek archaeological sites. Economic, political, social and psychological parameters may contribute to the presentation of the identity of a place since places need to differentiate themselves from each other to assert their unique and distinctive characteristics (Kavoura, 2013; Kavoura & Katsoni, 2013) in an attempt to satisfy tourists and visitors and project the distinct characteristics of a place whether these are museums, heritage sites etc. A critical approach towards the implementation of communication activities is necessary as literature has shown (Kavoura & Bitsani, 2013) but also in the creation of an international audience which will be paramount for the sustainable development of Greece at the time of vital importance.

References

Instructions to Authors for Word template

1. Locking of Copyright:

The copyright line is locked in the Procedia templates. The author may not edit the same and making it editable only PSMs. If there are any copyright changes required, you are requested to contact Journal Manager through Guest Editors. For editable the below mentioned steps must be followed:

Steps:
- Click on copyright statement
- Click on Properties in Developer tab
- Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking and then Press ok

2. Docm format:

We have added macros in the Word templates for the below mentioned features. And since macros are not supported in doc and docx format we created the templates of all Procedia titles in .docm format.

- Removal of all highlights
- Accept track change
- Locking of Rules

If .docm format needs to convert in docx format then the following steps must be performed:

Steps:
- Press Alt F11
- Click on Project (JID_Template)
- Enter "thomson" in Project Password
- Click on Microsoft Word Objects
- Click on ThisDocument under Microsoft Word Objects
- Delete all macros under General
- After deletion close the Code and Project (JID_Template) windows
- From File menu click on save as type .docx option

3. Comments added in the margin in Word master templates:

There are instances where author raising queries on what to do with key information lines such as “volume, page numbers”, “Conference title per issue” and “Copyright entity, year, copyright company Elsevier Ltd./B.V./Inc. and Organizer Name” in the copyright statement and for these concerns the comments have been inserted in the Word template to guide Author/JM about the information to be inserted by them in these fields.

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. If the authors do not want to get the comments appearing in print, the authors must remove the comments from the Word template before printing by changing the Print markup setting of word using the following steps:

Steps:
- Click the File tab
- Click Print
- Under Settings, click the arrow next to Print All Pages
Instructions to Authors pages to be excluded from Print:

- Click the File tab
- Click Print
- Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the document or the section. For example, type 1, 3, 1-5

4. PDF creation from Word master template:

While creating PDF from Word template the below given step should be followed to avoid difference in trim size and margin of the Word template and the PDF created.

Steps in Word 2007 and 2010:

- Click the File tab
- Click Save As
- Under Save as type, click the arrow next to PDF (*.pdf)
- Click Save

In Word 2003 the PDF can be created by using “Convert to Adobe PDF” symbol in tool bar or the required paper size can be adjusted in the Adobe PDF settings given in the Properties tab on the Print option.

5. Reference styles used in Procedia master templates:

<table>
<thead>
<tr>
<th>Title</th>
<th>Reference style</th>
</tr>
</thead>
<tbody>
<tr>
<td>AASPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>AASRI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>APCBEE Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>EGYPRO</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>FINE</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>IERI Procedia</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>MSPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PHPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>PIUTAM</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>Procedia CIRP</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>PROCHE</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROCS</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROENG</td>
<td>1 Numbered</td>
</tr>
<tr>
<td>PROENV</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROEPS</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROFOO</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>PROTCY</td>
<td>3 Vancouver Numbered</td>
</tr>
<tr>
<td>PROVAC</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>SBSPRO</td>
<td>5 APA</td>
</tr>
<tr>
<td>SEPRO</td>
<td>3a Embellished Vancouver</td>
</tr>
<tr>
<td>AQPRO</td>
<td>2 Harvard</td>
</tr>
<tr>
<td>UMKPRO</td>
<td>5 APA</td>
</tr>
</tbody>
</table>